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About This Document

This document describes how to use the GEMPLUS WinGPR application.

This document assumes that you are familiar with smart card and smart card reader
technology, as well as your PC's hardware.

The following paragraphs tell you where to find information when you need it. It is
important that you read this section to use this document to its full potential.

Overview

Read this section for a general description of the WinGPR application.

Installing WinGPR

Read this section for instructions on how to install, run and exit from WinGPR, and how
to assign the reader that you want to use.

Managing Sessions

Read this section for information on how to assign the type of card that you are using
and how to open, close, and switch sessions.

Trace Files

Read this section for information on how to record and replay sequence traces.

Card Commands

Read this section for information on how to send APDU commands and binary
commands to the card.

Reader Commands

Read this section for information on how to send commands to the reader, and how to
record, replay, modify and delete commands stored in macro files.

Reader Management

Read this section for details on how to view the reader information, how to change the
protocol and baud rate of the reader, how to read and load the reader memory, and
how to make active and deactivate the card driver or OS Filter in the RAM or Flash
memory.

This section also describes how you can put the reader into the low energy
consumption idle mode, how to return it to operating mode and how to reset it.

Introduction

Audience

How to Use This Document
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Overview

WinGPR provides a menu driven screen interface with all types of smart cards
supported by the GPR400 Compact Smart Card Reader Writer that runs under
Windows.

WinGPR enables you to select enhanced GPR features such as memory downloads.

To view information about WinGPR, click on the About option in the Help menu.

To view information about the PCCard, click on the PCCard Infos option in the
Options menu. The PCCard Info dialog box opens:

PCCard Dialog Box

Introduction

Product Information
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Installing WinGPR

This section describes how to install, run and exit from the WinGPR application, and
how to assign the reader that you want to use.

The steps below describe how to install WinGPR.

1. Insert the diskette labeled WinGPR into your PC floppy drive.

2. Type X:\setup, where X is your floppy drive source.

3. Follow the instructions on the screen.

To run WinGPR, click on the WinGPR icon in the GEMPLUS Applications window.
Before you can run the program you also have to select a reader.

WinGPR has a Wait Mode  option that enables you to have the program open but not
running. You can also choose if you want to run the Warnings  option.

You can run WinGPR in the Novice or Expert mode. The Novice Mode is the default
mode.

To prevent you from having to close the application between uses, WinGPR has an idle
mode.

To put the application in idle mode, click on the Wait Card  option in the Card menu or

click on the  icon in the toolbar. The application is iconized, and opens when you
insert a card into the reader.

To run WinGPR using the Warning  option, click on the Warning  option in the Options
menu.  A check mark next to the option shows that the option is active.

When this option is active, warning messages appear on the screen to highlight certain
functions you must carry out.

Introduction

Installing WinGPR

Running WinGPR

WinGPR in Wait Mode

Warnings Option
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Note:  Make sure that your card supports these functions before you use them. Using
these functions with the wrong type of card may cause permanent damage to the card.
The Expert mode offers the following additional options:

Option Menu Description
Fast Open Session Card Opens a session in half the time of the standard

command.
Load Reader Loads data to the RAM or Flash memory.
Read Reader Reads data from the RAM or Flash memory.
Activate/Deactivate Reader Activates or deactivates the card driver or OS

filter in the RAM or Flash memory.

To use the Expert option, click on the Expert option in the Options menu.

Before you run the application, make sure you assign the reader that you are using.
Follow the steps below to assign the reader.
Changing the reader after the Sleep  command does not wake the reader up, even if
WinGPR acts as if the reader is awake. To communicate with the reader, carry out a
reset.
1. Select the Selection option in the Reader menu. The Reader - Selection 

dialog box opens.

Reader - Selection Dialog Box

2. Highlight the reader that you want to assign, then click OK.

To exit from WinGPR, click on the Exit option from the File menu.

Running WinGPR in Expert Mode

Selecting a Reader

Exiting from WinGPR
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Managing Sessions

This section describes how to assign the type of card that you are using and how to
open, close, and switch sessions.

WinGPR supports all memory and microprocessor cards. The steps below describe
how to assign the type of card that you are using with your reader. Any changes that
you make are registered after the next open session.

1. Click on the Select Card  option in the Card menu. The Select Card dialog box
opens listing the available card types.

Select Card Dialog Box

2. Click on the type of card that you are using so that it is highlighted.

3. Click Ok to select this card type for the next session, or click Save as Default to
keep this card type as the default selection.

Before you can use your smart card to perform transactions, such as sending
commands, you have to open a session.

Select the Open Session (Reset)  option in the Card menu, or click on the  icon in
the toolbar. The card returns the Answer-to-Reset .

Note: Non-ISO cards do not support this function. Call GEMPLUS before using
your card to check that you can use this function.

Introduction

Assigning Your Card Type

Opening a Session

Fast Open
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WinGPR enables you to open a session (cold reset) with the GPR400 at twice the
speed of the standard open session command. This option is only available when you
are running in the expert mode.

Select the Open Fast Session option in the Card menu, or click on the  icon in the
toolbar. The card returns the Answer-to-Reset .

After you finish transacting with a card, you close a session, leaving the network
available for transactions with other cards.

Select the Close Session (Vcc Off)  option from the Card menu. Removing the card from
the reader has the same effect as the Close Session command.

If the card supports more than one protocol or baud rate, you can switch between
them, informing the reader of the switch, removing power from the card.

Example:
The card is used in an ATM banking application. When you enter the card into the ATM
reader, the card is recognized and powered up using T=0, 9600 baud. When you enter
it into the toll reader, it switches to 115200 baud.

Select the Switch Session  option from the Card menu. The card returns the Answer-to-
Reset.

Closing a Session

Switching Between Sessions
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Trace Files

This section describes how to record and replay sequence traces.

WinGPR enables you to record a sequence of tasks, then see the code generated by
WinGPR to perform these tasks. The task coding is recorded in trace files. You typically
use trace files:

• to see how you program the recorded tasks

• to troubleshoot by replaying exactly what went wrong

• to replay simple personalization sequences

Follow the steps below to record a card exchange.

1. Open a trace file to record the sequence in by selecting the New Trace  option from

the File menu, or click on the  in the toolbar. The icon changes to  and
the New Trace File dialog box opens:

2. To Record the Sequence to a New Trace File, type a file name into the File Name
box.

To Record the Sequence to an Existing Trace File:

i. Type an existing trace file name or select one from the drop down list.

ii. Click OK or press ENTER.

When you enter the trace file name, all the card exchanges that you perform are
recorded in the file until you close it.

Introduction

Recording Card Exchanges
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To stop recording a card exchange, close the trace file by selecting the Close Trace
option from the File menu.

WinGPR enables you to replay a card exchange that you recorded in a trace file to see
the code that was generated to perform the task.

You can replay a task sequence in one of two modes: single step mode or run mode.
Single step mode replays each command individually, waiting for you to prompt it to
replay the next step. Run mode replays the recorded card exchange from beginning to
end.

You access both modes from the Play TRACE File dialog box. You can mix these two
modes, starting the trace in run mode for example and switching to single step mode if
an unacceptable code is returned. You can finish the trace in the run mode, or continue
step by step.

You can control the status code returns and the data that is returned by the card using
the Status controls  options and the Data controls  options. See Status Controls  and Data
Controls  below.

Follow the steps below in order to run a trace file:

1. Click on the Replay option in the File menu, or click on the  icon in the toolbar.
The Open a Trace File (Replay) dialog box opens.

2. Type the name of the trace file that you want to run in the File Name box, or select
a name from the drop down list.

3. Click OK. The Replay dialog box opens.

4. Click on Run to replay the trace in run mode or Next Step to replay the trace in
single step mode. The trace begins.

5. Click on Restart to restart the replay if it is interrupted, or to advance to the next
step if you are replaying in single step mode.

Note: If you select the continuous option, the replay does not stop regardless of the
status control selected.

When a replay is interrupted, the line with the error in it is highlighted, and the expected
data is shown.

Select this To do this

Status not controlled Ignore the status controls

Status = 90 00 Stop the replay if the card returns a status value
other than 90 00

Status = File status Stop the replay if the card returns a status value
other than that recorded in the trace file

Ending a Card Exchange

Replaying a Task Sequence

Status Controls
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Note: If you select the continuous option, the replay does not stop regardless of the data
control selected.

Select this To do this

Data not controlled ignore the data control

Data = File data stop the replay if the card returns data that is
different from that stored in the trace file.

Data Controls
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Card Commands

This section describes how to send APDU commands and binary commands to the
card.

Before you send a command make sure that you opened a session.

Follow the steps below to send an APDU command to a card:

1. Click on the APDU Exchange  option in the Card menu, or click on the  icon in
the toolbar. The APDU Exchange dialog box opens:

Note: One MPCOS command requires that you click in the Special box. It is only
possible to click in this box when the Length In = 0. See the appropriate card reference
manual for further detail.

2. Select a command that you previously saved in a macro, or enter a new command.
See below.

To enter a command saved in a macro, see Using Macros .

To Enter a New Command

Move the cursor to the Commands  field and enter the command fields as follows:

In this field Enter this:

CLA instruction class

INS instruction code

P1 parameter 1

P2 parameter 2

Introduction

Sending Commands
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Length In length of data (if any)
that you enter with the
command

Length Expected length of data that you
expect the command to
return.

See the appropriate reference manual for the card that you are using for further
detail about commands.

3. Click on Send to send the command. The command returns its response in the
Response  field. the following tables describes these fields:

This field Holds this data

Card Status status code that the card returns. See the appropriate
reference manual for the card that you are using.

Length out length of the data (if any) that the card returns in
response to the command.

Data data (if any) that the card returns in response to the
command

You can save the APDU commands that you send a card by entering them in a
macro. This is a useful shortcut for replaying commands that you use often. The
paragraphs below describe how to record macros and how to replay them from a
file.

Note: You cannot use the same macro name twice. Macro files can contain a
maximum of 255 macros.

1. Select the APDU Exchange  option from the Card menu or click on the  icon in
the toolbar. The APDU Exchange dialog box opens.

2. Click on the File option button in the APDU Exchange dialog box. The Open a
Macro File dialog box opens.

3. Type the macro file name in the File Name box. Make sure that you include the
.amf file extension.

4. Click on OK or press ENTER to return to the APDU Exchange dialog box.

5. Type the macro name in the Name box.

6. Enter the APDU command or commands that you want to record in the macro
following the instructions provided in Sending APDU Commands .

7. Save the macro by clicking on the Add+ option button.

Using Macros

Recording Macros



Card Commands

© GEMPLUS 11

1. Select the APDU Exchange  option from the Card menu or click on the  icon in
the toolbar. The APDU Exchange dialog box opens.

2. Click on the File option button in the APDU Exchange dialog box. The Load a
Macro File dialog box opens.

3. Type or select the name of the macro file that contains the macro that you want to
replay in the File Name box.

4. Click on OK or press ENTER to return to the APDU Exchange dialog box.

5. Type the macro name in the Name box or enter a macro from the drop down list.

6. Click OK to send the macro.

1. Select the APDU Exchange  option from the Card menu or click on the  icon in
the toolbar. The APDU Exchange dialog box opens.

2. Click on the File option button in the APDU Exchange dialog box. The Load a
Macro File dialog box opens.

3. Type or select the name of the macro file that contains the macro that you want to
modify in the File Name box.

4. Click on OK or press ENTER to return to the APDU Exchange dialog box.

5. Modify the command contents for the macro.

6. Click on the Mod option button. The macro is modified.

1. Select the APDU Exchange  option from the Card menu or click on the  icon in
the toolbar. The APDU Exchange dialog box opens.

2. Click on the File option button in the APDU Exchange dialog box. The Load a
Macro File dialog box opens.

3. Type or select the name of the macro file that contains the macro that you want to
delete in the File Name box.

4. Click on OK or press ENTER to return to the APDU Exchange dialog box.

5. Select the macro that you want to delete from the drop down list.

6. Click on the Del- option button. The macro is deleted.

When you send a command to the reader or to the card through the reader, the PC
waits a certain amount of time for a response. This option enables you to determine this
time length.

To initialize or change this time, select the Cmd TimeOut option from the Card menu.
The Cmd TimeOut dialog box opens displaying the current time-out period:

Replaying Macros

Modifying Macros

Deleting Macros

Command Timeout Mechanism
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Cmd Timeout Dialog Box

To change this time, enter the time that you want in the Time Out box then click
on the Modify option button. The time-out period is changed.
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Reader Commands

The following paragraphs describe how to send low level commands to the reader. It
also describes how to record, replay, modify and delete commands stored in macro
files.

You can send commands to the reader in hexadecimal or ASCII format.

Follow the steps below to send commands to the reader.

1. Select the Exchange  option from the Reader menu. The Reader Exchange dialog
box opens:

Reader Exchange Dialog Box

2. Select a command that you previously saved in a macro, or enter a new command.
See below.

To enter a command saved in a macro, see Using Macros .

To Enter a New Command

i. Enter the type and length for the data, and enter the data that you want to
send.

ii. Click on the Exchange  option button. The data returned from the reader
appears in the Received Data box.

Introduction

Sending Commands
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You can save the IFD commands that you send to a reader by entering them in a
macro. This is a useful shortcut for replaying commands that you use often. The
paragraphs below describe how to record macros and how to replay them from a
file.

Note: You cannot use the same macro name twice. Macro files can contain a
maximum of 255 macros.

1. Select the Exchange  option from the Reader menu. The Reader Exchange dialog
box opens.

2. Click on the File option button. The Open a IFD Macro File dialog box opens.

3. Type the macro file name in the File Name box. Make sure that you include the .imf
file extension.

4. Click on OK or press ENTER to return to the Reader Exchange dialog box.

5. Type the macro name in the Name box.

6. Enter the command or commands that you want to record in the macro following
the instructions provided in Reader Commands .

7. Save the macro by clicking on the Add+ option button.

1. Select the Exchange  option from the Reader menu. The Reader Exchange dialog
box opens.

2. Click on the File option button in the Reader Exchange dialog box. The Open a IFD
Macro File dialog box opens.

3. Type or select the name of the macro file that contains the macro that you want to
replay in the File Name box. Make sure that you include the .imf file extension.

4. Click on OK or press ENTER to return to the Reader Exchange dialog box.

5. Type the macro name in the Name box or enter a macro from the drop down list.

6. Click OK to send the macro.

1. Select the Exchange  option from the Reader menu. The Reader Exchange dialog
box opens.

2. Click on the File option button in the Reader Exchange dialog box. The Open a IFD
Macro File dialog box opens.

3. Type or select the name of the macro file that contains the macro that you want to
replay in the File Name box. Make sure that you include the .imf file extension.

4. Click on OK or press ENTER to return to the Reader Exchange dialog box.

5. Type the macro name in the Name box or enter a macro from the drop down list.

6. Modify the command contents for the macro.

7. Click OK to send the macro.

1. Select the Exchange  option from the Reader menu. The Reader Exchange dialog
box opens.

2. Click on the File option button. The Open a IFD Macro File dialog box opens.

3. Type the macro file name in the File Name box. Make sure that you include the .imf
file extension.

Using Macros

Recording Macros

Replaying Macros

Modifying Macros

Deleting Macros
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4. Click on OK or press ENTER to return to the Reader Exchange dialog box.

5. Type or select the macro name in the Name box.

6. Click on the Del- option button. The macro is deleted.
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Reader Management

This section describes how to view the reader information, how to change the protocol
and baud rate of the reader, how to read and load the reader memory, and how to
make active and deactivate the card driver and OS Filter in the RAM or Flash memory.

It also describes how you can put the reader into the low energy consumption idle
mode, and how to return it to operating mode, and how you can reset the reader.

When you are not using the reader you can put it into a low energy consumption idle
mode. When this mode is active you can no longer use the following options:

Menu Option

File Replay

Card Open Session

Card Open Fast Session

Card Switch Session

Card Switch Protocol

Card Close Session

Reader Exchange

Reader Status

Reader Load

Reader Read

Reader Activate/Deactivate

Reader Sleep

Reader Reset

To put the reader into idle mode click on the Sleep option in the Reader menu.

To put the reader into operation after invoking the idle mode, click on the Wake up
option in the Reader menu.

To reset the reader click on the Reset option in the Reader menu. You are asked to
confirm your choice.

This has the same effect as removing the reader - all the active memory is erased.

This command works even when there is no GPR present. When the No Response
from Reader  appears while a GPR is connected, carry out a reset.

You can find out the working specifications of the current reader by clicking on the
Status option in the Reader menu.

The Reader Status dialog box opens displaying the following reader information:

Introduction

Putting the Reader into Idle Mode

Resetting the Reader

Current Reader Information
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Reader Status Dialog Box

Protocol = communication protocol the reader is using

Exchange size = size of the exchange buffer

OS string = operating system identifier

specific string = indicates if the reader has flash memory, if a card is 
inserted in the reader, if the driver is active, as well the 

clock frequency.

Click on Close to close this dialog box.

Click on Help to bring up the on-line help.
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Note: This function does not work with the GPR400.

You can change the protocol and baud rate that the reader communicates with by
using the Switch Protocol command.

1. Click on the Switch Protocol option in the Card menu. The Switch Protocol dialog
box opens displaying the current protocol and baud rate in use.

Switch Protocol Dialog Box

2. Click on the drop down list and select the protocol that you want to switch to.

3. Click on the Switch option button. The protocol is changed.

4. Click on Close to close this dialog box. Click on Help to bring up the on-line help.

Changing Protocol & Baud Rate
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You can read the RAM and the flash memory (if you have this option) of the reader.
You can only read up to address 6D3 in the RAM - for a standard product.

1. Click on the Read option button in the Reader menu. The Read dialog box opens.

Read Dialog Box

2. Click on the RAM radio button to read the RAM, or the Flash radio button to read
the flash memory.

3. Set the address that you want to start reading from and the number of bytes that
you want to read.

4. Click on Read. The Read Result dialog box opens and you can read the data that
is in the memory of the reader.

Read Result Dialog Box

5. To save the result, click on Save As. The standard Windows® Save File as window
opens. Save the result under the file name of your choice then click OK. It is stored
in binary form.

To exit from the window without saving the configuration, click on Close.

Reading GPR400 Memory (Expert Mode Only)
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If there are changes or additions to the OS filter, you can download the file that
contains the changes to the RAM or the flash (if you have this option) memory.

You can only load a driver in the flash memory for a synchronous card at the 2100
address. To make this driver active you have to select address 100 in the
Activate/Deactivate window.

1. Click on the Load option in the Reader menu. The Open File to be Loaded dialog
box opens.

2. Select the file that contains the data that you want to load to the memory, then click
OK. The Load dialog box opens.

Load Dialog Box

3. Choose whether you want to load the RAM or the Flash memory and set the
address that you want to load from.

If you want to erase the flash memory before loading, click in the check box at the
bottom of the screen.

4. Click OK.

Note: At present you have to use the filter and OS provided by GEMPLUS. If you want to
make changes to either of these, contact GEMPLUS.

Note: If you activate invalid data, you have to reset the reader.

You can activate or deactivate a card driver and the OS filter in the RAM or the
flash memory (if you have this option) of the reader.

1. Click on the Activate/Deactivate  option in the Reader menu. The
Activate/Deactivate dialog box appears.

Loading a File to the GPR400 Memory  (Expert Mode Only)

Activating & Deactivating a Module or the Memory   
(Expert Mode Only)
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Activate / Deactivate Dialog Box

2. Select the entity that you want to activate or deactivate by clicking in the
appropriate radio button.

Example:
If you want to deactivate the card driver in the RAM, click in the card driver radio
button and the RAM radio button.

3. Set the address that you want to start the activate/deactivate command at, then
click on the Activate or Deactivate button.


